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1 Introduction 

1.1 Introduction to EasiShare 

EasiShare is a file-sharing tool that allows users to share their files securely across different devices and 

with other users. Documents are stored on a server and are readily accessible to their owners and the 

recipients with whom the documents have been shared. Shared documents have an expiry timer, after 

which access rights are automatically revoked. 

 

1.2 EasiShare Desktop 

The EasiShare Desktop allows EasiShare users to manage storage, files, and create Upload Requests 

through a Desktop Explorer interface. Users can create new folders, upload files, download files, modify 

existing files, create upload requests, and more. Most of these actions will take effect directly in the 

storage. 
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2 Login 

2.1 Getting Started 

To log in for the first time, 

1. Launch the EasiShare desktop application 

2. In the URL field, enter your organisation’s EasiShare domain. 

a. Example: https://clientname.easishare.com/ws or https://clientname.easishare.com/esws 

3. Enter your Username and Password. 

a. If your organisation uses Single Sign-On (SSO), skip entering your username and 

password, and instead check the Use Single Sign-On box. 

4. If your EasiShare connection requires a proxy, enter the proxy details. (Optional: Skip this step if 

not applicable.) 

5. Click Save to proceed. 
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Login Errors: 

If you encounter any error message below, 

1. Username or password entered does not exist. Check that you have entered a correct username or 

password. 

 

2. The device which you are using has been disabled. Check with your Administrator. 

 

3. Your account is locked. Check with your Administrator. 

 

4.  Your must change your password before login. 
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2.1.1 Update Settings 

1. Click the File tab, then select Settings. 

2. You can update URL, Username, or Password as needed. 

3. To enable Single Sign-On (SSO), tick the Single Sign-On checkbox. 

4. Click Refresh Settings to update drive permissions and user policies 

5. Click Save to apply the changes. 

 

 

 

2 

4 

3 
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2.2 Accessing EasiShare 

1. Logging in will direct you to the page as shown below. You should see drive(s) that you can 

access. 

 

 

Files & Folders shared by EasiShare users to you. 

A dedicated drive for your personal working files. 

Files and folders you’ve shared with others are listed here. You can 

review, revoke, or extend the Share as needed. 

After you initiate a file upload request to non-EasiShare users and they 

complete the upload, you can download the files from this page. 

Shared Drives/Folders that have been given permission to you by other 

EasiShare users for collaborating typically on peer or team level (Error! 

Reference source not found.where the owner has used the Manage 

function) 

Drives that have been given permission to you by the EasiShare 

Administrator for collaboration on a department level 

Folders that you, as the Owner, have shared with others are listed here. 

This is also where you can review the permissions granted to each user. 

Files and folders you’ve marked with a star. From here, you can easily 

open them or quickly navigate to their original location. 

A record of your recent downloaded, previewed or edited files, up to 

maximum of 50 entries. 

 Tracks access, changes, or sharing activity on specific files and folders 

you're monitoring for security or collaboration purposes. 

Access your checked-out files and perform a quick check-in when 

editing is complete. 
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2. You can navigate or access a drive located on the Drive List on the left panel while the common 

functionalities are in the Home tab at the top panel. 

 

3. When you click on the Share tab, you can share files or folders, request files to be uploaded into 

the specified folder, and generate a link for the selected item to be accessed via the link. 

 

2.3 Switching Views 

1. To change view, go to the view tab. 

2. If the user clicks on the List view icon  , the display will change to List view. 

Drive List 

Refresh 

Search Drive Content 

Common Functionalities 
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3. For the icon view, three sizes of choice are given, from left to right, small, medium, and large 

views. 

 

4. Users will be able to sort according to their preference with the help of sorting menu. 

2.4 Concurrent Login 

1. If the administrator has enabled concurrent login, the user would be able to login to multiple 

devices using the same user account. 

2. If the administrator has disabled concurrent login, the user would only be able to access his user 

account on one device at a time. 

▪ Whenever the system detects concurrent access, it will display the message below to sign 

out from previous devices before proceeding to login in the current device. 

 

3 

1 
2 



EasiShare Desktop User Guide  

 

© Copyright 2025 Inspire-Tech Pte Ltd. All Rights Reserved. Page 13 of 94 

 

▪ For other devices, the same user account will be automatically signed out. To continue 

using those devices, you will need to log in again. 

3 File Operations 

3.1 Create a File 

1. Click on the New Document icon  under the Home tab in the top panel. 

2. Choose a type of file from the drop-down list. 

3. The document will be created in the current folder. 

 

3.2 Upload Files 

3.2.1 Using Upload Feature 

1. Click on Upload File . 

1 

2 

3 
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2. Select the file/folder you wish to upload. You may select multiple files/folders at a time. Tip: Hold 

down the Ctrl key (on your keyboard) and click each file or folder you want to select 

3. Click Open 

 

3.2.2 Using “Drag & Drop” Method 

1. Drag and drop file/folder from Windows File Explorer to EasiShare Desktop. You may select 

multiple files/folders at a time. 

1 

2 

3 
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3.2.3 Check Upload Status 

1. A status bar will pop-up and show the progress of the activity such as Completed, Failed, 

Cancelled, or In Progress. 

2. Click on File Activity icon  located at the top panel. 

3. From here, you can click on My Activity, it displays your action history. 

 

 

2 

3 
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4. In Sync History, it will display the sync operations. 

 

Note: The records in My Activity and Sync History will be retained during the same session. If the Desktop 

application is exited, these records will be cleared. 

3.2.4 Uploading a Virus File 

When a virus file is being uploaded directly or to the sync folders in File Explorer, the following steps will 

take place: 

1. The error message below will be displayed in EasiShare: 

 

2. An email notification regarding the virus detection will be sent to the user: 

 

Note: 

This scenario only applies if customers have implemented Virus scanning in EasiShare. If not turned on, then 

ignore this scenario. 

4 
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3.3 Copy/Paste 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may select 

multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Copy  along the Home Tab located at the top panel.

 
3. Select the drive/folder you want to move your file(s)/folder(s) to. 

4. Paste  the file(s)/folder(s) at the selected location. 

1 

2 
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Note: Moving a file/folder that is shared may cause the link to break. Recipients may not be able to 

access such file/folder. The user can also use shortcut keys like Ctrl + C to copy, Ctrl + X to cut and Ctrl + 

V to paste the file. 

 

3.4 Download 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may select 

multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Download To  along the Home Tab located at the top panel. Alternatively, you can 

double click on the file(s)/folder(s) name. 

You can refer to Section Check In/Out which explains how double-clicking on the file(s)/folder(s) name will 

automatically download it. 

4 

3 
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3.5 Delete 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may select 

multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Delete  along the Home Tab at the top panel. 

3. Click Yes to confirm the deletion 

2 

1 
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3.6 Recycle Bin 

The Recycle Bin temporarily stores deleted files and folders from the drive they were removed from. Items 

in the Recycle Bin continue to occupy space on the drive until they are removed. The following features 

are available when you go to the Recycle Bin of a drive and select file(s)/folder(s): 

▪ Download To 

1. Users can proceed to download the deleted file(s)/folder(s) in his Recycle Bin in Local 

Drive/PC by clicking on the Download To icon . 

2 

1 

1 
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2. The pop-up below would be displayed for the user to select the storage area to save the 

document: 

 

▪ Restore  

1. Users can restore deleted items from his Recycle Bin to the original storage drive of the 

document by clicking on the Restore icon  

2. The file(s)/folder(s) will be restored in the original drive. 

 

▪ Delete 

1. Users can delete the items permanently from their Recycle Bin by clicking the Delete icon  

2. The pop-up below would be displayed for the user to confirm the deletion process. 

3. If ‘No’ is clicked, the action will be cancelled, and the file will stay in the Recycle Bin. 

If click ‘Yes’, the file will be removed permanently from the server. 

Note: A copy will be reserved in the Admin’s Recycle Bin if the organisation has Admin Recycle 

Bin feature turned on. 
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3.7 Copy Path 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may select 

multiple files/folders at a time by clicking on multiple checkboxes. 

2. Click on Copy path  along the Home Tab at the top panel. 

 

3. Users can proceed to paste this path link into an email draft and send it to internal collaborators 

for easy access. 

 

2 

1 

3 
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3.8 Send as Link 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may select 

multiple files/folders at a time by clicking on multiple checkboxes. 

2. Right-click on the file. Go to ‘Share’ and click ‘Send as Link’. 

 

3. The user will be automatically directed to Outlook, with the file links generated. User can proceed 

to send this link via email. Note: The links can only be opened by internal users. 

 

3.9 Preview 

1. Select the file. To select, click on the checkbox beside the file name. 

2 

1 

3 
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2. Select Preview  located at the top panel. 

 

A pop-up box will appear with the preview of the file. 

 

3.10 Preview a File with No Download Permissions 

1. Select the file. To select, click on the checkbox beside the file name. 

1 
2 

3 
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2. Select the Preview  located at the top panel. 

 

A pop-up box will appear with the preview of the file. 

 

Note: Users with No Download permissions previewing a file will have a watermark displaying the 

user’s name and email address. 

3 

1 

2 
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3.11 Document Tag 

The Document Tag function allows users to apply tags to files, provided the feature is enabled for the 

organisation. These tags may include sharing restrictions, as defined by the administrator. Tagging may 

also be mandatory during the file upload process. 

1. Select the file. To select, click on the checkbox beside the file name. 

2. Select Document Tag  located at the top panel. 

 

3. Choose the appropriate tags for this file. 

4. Click Apply to All to tag the file with the selected tags. 

 

 

4 Folder Operations 

4.1 Create a New Folder 

1. Click on a drive located in the Drive List along the left panel to navigate to the new folder’s 

location. 

2. Click on New Folder  along the Home Tab located at the top panel. 

3. Enter folder name in the input box. 

4. Press Enter. 

 2 1 

3 

4 

5 
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4.2 Rename a Folder 

1. Select the folder. To select, click on the checkbox beside the folder name. 

2. Click on Rename  along the Home Tab located at the top panel. 

 

3 

2 

1 

2 

1 
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3. Enter new folder name. 

4. Press Enter.

 

5 Drive Operations 
For users who have many drives in the drives list, it would be helpful to rearrange and group the drives. 

These functions do not affect the permissions and are for organising purposes only, except for Remove 

My Access for shared drives. This is covered in Section Remove My Access from Shared Drive. 

5.1 View Drive Permissions 

To view your permission to the drive, you can hover your mouse over the drive and the permission 

appears in the tooltip. 

 

 

3 
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5.2 Pin 

1. Select the drive from Your Drives section 

2. Right click the drive 

3. Click Pin 

4. The drive will be in Pinned section 

 

5.3 Unpin 

1. Select the drive from Pinned section 

2. Right click the drive 

3. Click Unpin 

4. The drive will be in Your Drives section 

 

5.4 Hide 

1. Select the drive from Your Drives section 

2. Right click the drive 

3. Click Hide 
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4. The drive will be in Hidden section 

 

5.5 Show 

1. Expand the Hidden section 

2. Select the drive 

3. Right click the drive 

4. Click Show 

5. The drive will be in Your Drives section 

 

5.6 Move Up, Down and Reset Order 

This section is applicable to the Pinned and My Drives section only. 

1. Select the drive 

2. Right click the drive 

3. Choose one of the following options 

a. Move Up: Shifts the drive one position higher in the list. 

b. Move Down: Shifts the drive one position lower in the list. 

c. Reset Order: Restores the drive to its original/default position in the list. 
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5.7 Category Colours 

1. Select the drive 

2. Right click the drive 

3. Hover over Category in the context menu. 

4. Select a colour from the available options. 

a. To remove a colour, select None 

 

5.8 Recalculate Drive 

The Recalculate Drive function performs a scan of your selected drive to: 

• Update storage usage, including total drive size and individual folder sizes. 

• Check for missing or newly added files 

• Refresh file paths, ensuring the drive correctly reflects the current file structure. 

 

Steps: 

1. Select the drive you want to update. 

2. Right-click on the drive. 

3. Choose Drive Information from the context menu. 
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4. Click Recalculate Drive. 

 

  

4 

3 
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6 Share 

 

Scenarios & How to use the functions 

 

Scenarios What do you (the initiator) do? What do the recipient do? 

I want to send documents to 

my vendor to download. 

Select doc & click on Share Click on the link & download 

the file(s). 

I want to send a set of files to 

my vendor to download. 

Either 

1) Put them in a folder, select 

the folder & click on Share 

2) Multi-select the files & 

click Share 

Click on the link from the email 

& download the files in a 

zipped folder. 

Initiator 

EasiShare Users/Groups 

Non-EasiShare Users 

Manage 

to Collaborate 

Share 

to perform one-way 

sharing of files/folders for 

recipient to download 

View/Upload files in 

Download files in 

Edit/Revoke Share Out 

Click on Email 
link to view &  
download files 
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I want to collaborate with my 

colleagues to allow them to 

contribute files for a project. 

Both my colleagues and I can 

upload and delete files in the 

same folder. 

Select a folder & click on Manage 

Set the permission as author for 

the colleagues. 

Login as user & click on Shared 

Drives with a different icon. 

e.g.   

6.1 Share 

Share function allows users to share file/folder to allow recipients to view or download and receive a copy 

of the file/folder(s). Any changes made to the file/folder(s) by the recipients will not affect the sender’s 

original copy. If you wish to collaborate with users, please use the Manage function. For a detailed guide, 

do refer to Section Manage Folder for Collaboration of this user guide. 

1. Select the file/folder you wish to share. You may select multiple files/folders. 

2. Click on Share  along the Share Tab located at the top panel. 

 

3. Enter the recipient’s name, email, and/or contact number. The contact number is only mandatory 

if you wish to enable One-Time Password (OTP) authentication; otherwise, you may leave it blank. 

If you provide a contact number, please ensure that the correct country code is included. 

2 

1 
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4. Click  to confirm recipient. Alternatively, you can press enter. 

Tip: After adding the recipient, the name and mobile number can still be edited by clicking on the 

respective fields. 

5. To import multiple recipients, click on Manage Recipients at the top right corner, click on Import 

Recipient List to browse for a CSV file to import a list of recipients with the headers Name, Email 

and Mobile. 

6. You can also export an empty template by clicking on Manage Recipient on the top right corner, 

click on Export Recipient List for exporting a list of recipients’ details that are added individually. 

7. If you wish to create a group, add two or more recipients with at least one external user, click on 

Manage Recipient on the top right corner, then click on Create Group  

8. Enter your message (optional). 

9. Enable/Disable settings you wish to apply. To find out in details how each feature works, refer to 

the respective sections below. 

10. Select checkbox to agree to your organisation’s terms and conditions. 

11. Click Share. 

Tips: 

• Internal users are indicated by a human-shaped icon  

• External users are indicated by a human-shaped icon with an arrow  

• To select an internal user, start typing the user's name; matching results will appear. 

Click on the user to add them to the recipient list and you may skip step 4. 

• External users/groups will only appear in the search results after you have shared with 

them at least once. 
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6.1.1 Share to User Group 

1. Select the file/folder you wish to share. You may select multiple files/folders. 

2. Click on Share  along the Share Tab located at the top panel. 

3. Enter the User Group name on the Name field and select the User Group(s) to share. 

  

9 

5 
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Tips: After adding the user group, the members of the user group can be displayed by clicking on 

show/hide members. 

4. Enter your message. 

5. Enable/Disable settings you wish to apply. To find out in details how each feature works, refer to 

the respective sections below. 

6. Select checkbox to agree to your organisation’s terms and conditions. 

7. Click Share. 

6.1.2 Share with Download Permission 

1. To begin sharing, refer to Section Share. 

2. Ensure that the option ‘Share with View Only’ was not enabled. 

3. Select checkbox to agree to your organisation’s terms and conditions. 

4. Click Share. 

7 

6 

5 

4 
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6.1.3 Share with ‘View Only’ Permission 

1. To begin sharing, refer to Section Share. 

2. Enable the option Share with View Only. 

3. Select checkbox to agree to your organisation’s terms and conditions. 

4. Click Share. 

 

Note: 

1. This feature only applies to Microsoft Office documents, PDF documents and images. 

2. A watermark will appear on the content viewed by your recipient. Refer to the screenshot in Section 

Preview a File with No Download Permissions 

6.1.4 Share with Link Expiry 

1. To begin sharing, refer to Section Share. 

2. Enable Link Expires 

3. Set the date and time by clicking on the calendar icon. 

4. Select checkbox to agree to your organisation’s terms and conditions. 

5. Click Share. 
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Note: 

1. The expiry date and time must be set at least an hour later than the current time. 

2. The maximum expiry date may also be restricted by your organisation policy. 

3. This feature may also be controlled by your central administrator. If you are unable to enable or 

disable, it may be due to your organisation policy settings. 

6.1.5 Share with One Time Password (OTP) 

Users normally turn on OTP if Share link wants to be more secure. End recipients can only download the 

documents when they enter a valid OTP. 

1. To begin sharing, refer to Section Share. 

2. Enable OTP 

3. Select checkbox to agree to your organisation’s terms and conditions. 

4. Click Share. 
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6.1.6 Share and Receive Notifications When Users Accessed the File/Folder(s) 

Enabling download notifications allows the user to be alerted when a recipient downloads or views the 

file. If this option is enabled and the recipient accesses the file multiple times, the user will receive a 

notification for each instance. 

1. To begin sharing, refer to Section Share. 

2. Enable Notifications 

Immediate: An email will be sent to your email inbox whenever a file is accessed 

Summary: An email summary of all downloads and previews are sent 15 minutes (default) starting 

from the time of the first action 

3. Select checkbox to agree to your organisation’s terms and conditions. 

4. Click Share. 
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6.1.7 Share with Number of Download Attempts 

Enable the number of attempts option to allow the user to limit the number of times the recipient can 

download the file. This option can be set as default in the policy; however, the user will not be able to 

enable/disable this option nor change the number of attempts once the policy is set. After the recipient 

downloads reaches the limit, the recipient will not be able to download the file. 

1. To begin sharing, refer to Section Share. 

2. Enable No. of attempts. 

3. Fill in the number of attempts the user can download the file. 

4. Select checkbox to agree to your organisation’s terms and conditions. 

5. Click Share. 

 

6.2 Access Shared Files/Folders 

6.2.1 Email Notifications 

Recipients can access the shared file(s) or folder(s) by clicking the link in the email notification. 

 

Note: For external recipients, they will only be able to view or download the specific file(s) or folder(s) that 

you have shared. 
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6.2.2 Shared In 

1. To access file/folder(s) shared by other internal users to you, click on Shared located along the left 

panel. 

2. Click Shared In  

 

Note: Internal users refer to users who have a registered account in EasiShare. 
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6.2.3 Shared Out 

This section explains how to access file(s) or folder(s) that you have shared one-way with internal or 

external users. 

1. Click on Shared located along the left panel. 

2. Click on Shared Out 

 

Note: External users refer to users who do not have a registered account in EasiShare. 

 

6.3 Edit/Remove Share 

There are two ways to edit share. Edits can be made at the file’s original location. Alternatively, you may 

choose to locate the file by the recipient’s name you have shared the file with in the Shared Out drive. 

6.3.1 Edit from File’s Original Location 

1. Select the file/folder. 

2. Click on Edit Share  at the top panel. 
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3. If you wish to change the link expiry date/time or turn off the notification for specific recipients, 

select the recipient you wish to apply changes to by clicking on the row that contains the 

recipient’s name 

4. Apply the changes by enabling/disabling the features or changing the date and time of the link 

expiry. It is also possible to update the No. of Attempts. To find out in details how each feature 

works, refer to the respective sections above. 

5. Click Update Share to confirm your actions. 

 

6. If you wish to resend the email for a recipient, click on  and the email will be sent immediately. 

7. If you wish to remove a recipient, click on  and click on Update Share to confirm your decision. 
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Note: 

1. Modifications to the settings will only be applied to the user you have selected. 

2. Some features may be controlled by your central administrator. If you are unable to enable or disable, it 

may be due to your organisation policy settings. 
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6.3.2 Edit from Shared Out Folder 

1. Click on Shared along the left panel, then select Shared Out. Select the user’s name. 

2. Select the file you wish to edit. 

3. Click Edit Share at the top panel. 

4.  A similar Edit Share pop-up window will appear. You may refer to Section Edit from File’s Original 

Location on how to edit, resend email or remove share. 

 

7 Manage Folder for Collaboration 
Managed Folder is a folder in EasiShare managed by designated users (owners) who control access 

permissions for other users to enable collaboration. The following chart shows the different types of 

permissions available. 

Permission Type Description 

Reader Permission to read files 

Contributor Permission to read, download, add and edit files 

Author Permission to read, download, add, edit and delete files  

Owner Permission to read, download, add, edit, delete and share files  

 

7.1 Manage Folder 

1. Navigate to the folder you wish to collaborate with other users. Select the folder. 

2. Click Manage  located on the top panel. 
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3. Enter the recipient’s name, email, and/or contact number. The contact number is only mandatory 

if you wish to enable One-Time Password (OTP) authentication; otherwise, you may leave it blank. 

If you provide a contact number, please ensure that the correct country code is included. 

 

4. Click  to confirm recipient. Alternatively, you can press enter. 

Tip: After adding the recipient, the name and mobile number can still be edited by clicking on the 

 icon. 

5. To import multiple recipients, click on Manage Recipients at the top right corner, click on Import 

Recipient List to browse for a CSV file to import a list of recipients with the headers Name, Email 

and Mobile. 

6. You can also export an empty template by clicking on Manage Recipients on the top right corner, 

click on Export Recipient List for exporting a list of recipients’ details that are added individually. 

7. If you wish to create a group, add two or more recipients with at least one external user, click on 

Manage Recipient on the top right corner, then click on Create Group. 

Tips: 

• Internal users are indicated by a human-shaped icon  

• External users are indicated by a human-shaped icon with an arrow  

• To select an internal user, start typing the user's name; matching results will appear. 

Click on the user to add them to the recipient list and you may skip step 4. 

• External users/groups will only appear in the search results after you have shared with 

them at least once. 
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8. Assign the permission type you wish to give to the user(s)/group(s). 

9. If you wish to apply the same permissions that has been set on another folder, select the folder 

name from the ‘Copy from’ dropdown list then click on the copy icon . 

10. Enable/disable folder expiry if you wish to set an expiry for the folder. 

11. Enable/disable OTP verification for external users accessing the folder 

12. Enable/disable quota if you wish to limit the folder size. 

13. Click Apply. 

14. When the permission has been granted, the user will receive an email notification. 
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Note: 

1. If the folder expiry is enabled and auto-delete is selected, after the folder expires and a pre-

defined number of days set by your central administrator, the folder will be automatically purged 

by the system. 

2. Some features may be controlled by your administrator. If you are unable to enable or disable, it 

may be due to your organisation policy settings.  
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7.2 Manage Folder to User Groups 

1. Navigate to the folder intended for collaboration and select it. 

2. Click on Manage in the top panel. 

 

3. Enter the group name, select the  button and assign the relevant permission type to the 

group. 

4. Enable/disable the necessary settings. 

5. Click Apply. 
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7.3 Access Shared Drive as An Internal User 

1. A Shared Drive is a folder shared to you for collaboration. It is labelled with a different icon 

. 

2. You may access the Shared Drive by clicking on it. 

3. Once your permission has been revoked, you will no longer see the files and folders under the 

Shared Drive. 

 

Note: Internal users refer to users who have a registered account in EasiShare.  
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7.4 Shared Drive Information 

1. Right click on a shared drive denoted by the icon  

2. Click on Shared Folder Information 

3. The shared drive information will appear in a pop-up window 

Shared Folder Information Description 

Owner(s) Displays the designated user(s) who manages the folder. 

My Permission  Displays the current access level assigned to the user for the 

selected folder 

Download Allow users to download files from the folder to their local device. 

Web Edit Allows users to open and edit files directly in the browser without 

downloading 

Expiry Date Indicates the date when the user's access to the folder will expire. 

Quota  Shows the maximum storage space allocated for the folder. 

 

7.5 Remove My Access from Shared Drive 

If you no longer require access to the shared drive, you can remove it from the drive list. 

1. Right click the Shared Drive that you wish to remove. 
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2. Click on Remove My Access. 

 

3. Click Yes. 
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8 File Request to Receive Files from External Users 

8.1 File Request 

1. Begin by selecting the drive where the file will be uploaded. 

2. Select New File Request  at the top panel. 

 

3. Enter the title of the file request. 

4. Enter the recipient’s name, email, and/or contact number. The contact number is only mandatory 

if you wish to enable One-Time Password (OTP) authentication; otherwise, you may leave it blank. 

If you provide a contact number, please ensure that the correct country code is included. 

 

Tips: External users are indicated by a human-shaped icon with an arrow . To select an external 

user, start typing the user's name; matching results will appear only after you have requested files 

from them at least once. Click on the user to add them to the recipient list and you may skip the 

next step. 

5. Click on  to confirm recipient. Alternatively, you can press enter. 

6. To import multiple recipients, click on Manage Recipients at the top right corner, click on Import 

Recipient List to browse for a CSV file to import a list of recipients with the headers Name, Email 

and Mobile. 

7. You can also export an empty template by clicking on Manage Recipient on the top right corner, 

click on Export Recipient List for exporting a list of recipients’ details that are added individually. 

8. If you wish to create a group, add 2 or more recipients, click on Manage Recipients on the top 

right corner, then click on Create Group. 

9. Enter your message (optional). 
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10. Enable/disable the settings you wish to apply. For details on how each feature work, refer to 

respective sections below. More settings are available by clicking on the arrow. 

 

 

11. Click Send Request. 

 

Note: Some features may be controlled by your central administration system. If you are unable to enable 

or disable, it may be due to your organisation policy settings. 
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8.1.1 File Request with Link Expiry 

1. To begin requesting files, refer to Section File Request 

2. Enable Link Expires 

3. Set the date and time by clicking on the calendar icon. 

4. Click Send Request. 

 

Note: 

Some features may be controlled by your central administrator. If you are unable to enable or disable, it 

may be due to your organisation policy settings. 
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8.1.2 File Request with OTP 

1. To begin requesting files, refer to Section File Request 

2. Enable OTP 

3. Click Send Request. 

 

Note: 

• To enable OTP, contact number field is mandatory. 

• This feature may be controlled by your central administrator. If you are unable to enable or disable, it 

may be due to your organisation policy settings. 
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8.1.3 Receive Notification When External Users Upload Files 

1. To begin requesting files, refer to Section File Request 

2. Enable Notifications. 

Per Upload: An email will be sent to your email inbox whenever a file is uploaded 

Summary: An email summary of all uploads are sent 60 minutes (default) starting from the time of 

the first upload 

3. Click Send Request. 
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8.1.4 Restrict Number of Upload Attempts 

1. To begin requesting files, refer to Section File Request 

2. View more settings by clicking on the arrow. 

3. Enable No. of Attempts. 

4. Specify the number of attempts you wish to limit. 

5. Click Send Request. 

 

Note: This feature may be controlled by your central administrator. If you are unable to enable or disable, 

it may be due to your organisation policy settings. 
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8.1.5 Restricted File Types 

1. To begin requesting files, refer to Section File Request 

2. View more settings by clicking on the arrow. 

3. View File Type Restrictions. 

4. Click Send Request. 

 

Note: This feature is controlled by your central administrator. The file type restrictions are set by the 

organisation policy settings. 
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8.1.6 Limit File Upload Size 

1. To begin requesting files, refer to Section File Request 

2. View more settings by clicking on the arrow.

 

3. Enable File Size Limit. 

4. Specify the file size limit and select either MB or GB. 

5. Click Send Request. 
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Note: This feature may be controlled by your central administrator. If you are unable to enable or disable, 

it may be due to your organisation policy settings. 

8.2 Upload Files Using File Request 

1. The recipient will receive an email notification. 

2. Click on the link provided. 

z  

3. The recipient will be directed to the upload page. 

4. Click on Upload File or simply drag and drop the files into the empty area. 
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8.3 Access Uploaded Files 

1. Click on Shared located along the left panel. 

2. Click on File Requests. 

3. Click on the title of the file request you wish to access. You will be redirected to the folder. 

4. Select the file to perform download or other file operations. 
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8.4 Edit File Request 

1. Select File Requests under Shared. 

2. Choose an active File Request to edit. 

3. Click on Edit File Request  located at the top panel.

 

4. A window will appear, follow the steps in each bubble for each intended purpose. 

5. Click on the Update Request button. 

 

  

To resend email 

Click to resend 

email to guest user 

To remove one of the 

guest users 

1. Click on delete icon 

2. Click on Update 

button to remove one 

of the guest users 

To change expiry date/time 

1. Select the expiry date/time 

2. Click on Update to update the 

expiry date/time & the guest user 

will receive an email again 

2 

1 

3 

5 



EasiShare Desktop User Guide  

 

© Copyright 2025 Inspire-Tech Pte Ltd. All Rights Reserved. Page 65 of 94 

 

8.5 Revoke File Request 

1. Select File Requests under Shared. 

2. Choose an active File Request to revoke. 

3. Click Revoke File Request .located at the top panel. 

 

4. A confirmation window will appear, click OK to proceed with File Request Revoke. 

 

9 Check In/Out 

When working in a shared environment, overwriting files can create challenges among users. To prevent 

files from being accidentally overwritten, users can initiate a check-out first before editing the file. Once 

the file has been updated, the user can upload the new version and check in. After the file has been 

checked in, other users can use the updated version to continue their editing. 

Action Meaning Purpose 

Check 

Out 

Lock the file for editing. Others can't edit 

until you check it back in. 

Prevents multiple people from editing the 

same file at once. 

Check In 
Save your changes and release the file so 

others can edit it. 

Updates the file with your changes and 

makes it available. 

Discard 
Cancel the check-out without saving any 

changes you made. 

Useful if you changed your mind or made a 

mistake while editing. 
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9.1 Auto Check Out a File 

1. Find the file you wish to check out then double click it. 

 

2. An edit icon will appear on the file icon on the user’s PC. 
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3. A lock icon will appear on the file icon on another user’s PC. 

 

4. Hover over the file name to find the name of the user who checked out the file. 

 

9.2 Manual Check Out a File 

1. Select the file you wish to check out. 

2. Click on Check Out  located at the top panel.
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3. An edit icon will appear on the file icon.

 

4. Hover over the file name to find out who checked out the file.

 

5. A new version will be created temporarily. This version is only visible to the user who checked out. 

Other users will only see the change in version after you have checked in. 

6. You can choose to perform any file actions. All actions are available to the user who checked out. 

Other users will be able to perform some actions only. 
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Note: Other users will be restricted from performing certain file operations such as delete, rename, 

copy/move on a file that has been checked out. Even when another user is sharing a file, the user is sharing 

based on the version that was prior to your check out. 

 

9.3 Check In a File 

1. Select the file that was checked out. 

2. Click Check In  located at the top panel. 

 

3. A pop-up window will appear. You may choose to retain check out after checking in and entering 

comments. Click Check In to complete the process. 

4. The edit icon on the file will disappear. 
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5. The version number that was created during check out will be recorded. This version is visible to 

all users. 

6. After checking in, all actions are available to all users. Any users can choose to perform any file 

actions as per normal. 
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9.4 Discard Check Out 

1. Select the file that was checked out. 

2. Click Discard Check Out at the top panel.

 

3. A pop-up will appear for the user to confirm discarding the check-out.

 

4. Click OK to proceed. 

5. The Lock Icon no longer appears on the file. 

6. The version number that was created during check out will be discarded. Refer to Section Manual 

Check Out a File for more details on how the version number was generated. 

7. Any users can choose to perform any file actions as per normal. All actions are available to all users. 
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Action Meaning Purpose 

Check 

Out 

Lock the file for editing. Others can't edit 

until you check it back in. 

Prevents multiple people from editing the 

same file at once. 

Check In 
Save your changes and release the file so 

others can edit it. 

Updates the file with your changes and 

makes it available. 

Discard 
Cancel the check-out without saving any 

changes you made. 

Useful if you changed your mind or made a 

mistake while editing. 

 

10 Versioning 

10.1 View Version 

 

1. Select a file. 

2. Click Show Versions  located at the top panel. 

 

3. A pop-window will appear. 

4. The version numbers will be displayed in descending order. 
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10.2 Create New Version 

1. Upload a file with the same name in the same folder. 

 

2. An overwrite message notification will appear and click Yes. 
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3. Click on Show Versions  located at the top panel. 

4. A pop-up window will appear. 

5. The version number increased by 0.1. 
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10.3 Restore Version 

1. Select the file you wish to restore. 

2. Click Show Versions  located at the top panel. 

3. A pop-up window will appear. 

4. Click the restore icon  next to that version. 

 

11 Sync 
When working on your documents it can be a challenge to upload/download content from EasiShare 

and/or to EasiShare constantly when there are updates at either ends. Sync feature has the convenience 

for users to add file(s)/folder(s) to sync which allows the uploading and downloading of updated 

file(s)/folder(s) on the fly. Once it is added, file(s)/folder(s) that are in your desktop will get updated from 

EasiShare in a timely manner which can be set and when users edit the file from their desktop upon 

closing, the file will be uploaded to EasiShare. 
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Action Meaning Purpose 

Add to Sync Marks a folder/file to be included in 

sync operations 

Enables selected content to be 

automatically synced to local storage 

or device 

Remove from Sync Unmarks a folder/file from ongoing 

sync 

Stops syncing the selected content to 

free up space or reduce bandwidth 

Sync Now Performs a quick sync that only 

processes items that have changed 

since the last sync 

To efficiently update files or data by 

syncing only the modified, added, or 

deleted items 

Full Sync Performs a comprehensive sync by 

scanning the entire synced directory 

regardless of change history 

To ensure complete accuracy 

between server and user’s machine 

by checking every file, typically used 

when inconsistencies or missed 

updates are suspected 

 

11.1 Add to Sync 

1. Select the file/folder. To select, click on the checkbox beside the file/folder name. You may select 

multiple files/folders at a time by clicking on multiple checkboxes. 

2. Select Add to Sync  located at the top panel. 
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3. The pop-up below would be displayed for the user to confirm the add to sync action. 

 

4. On success, a notification and a green tick  will appear. 
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11.2 Remove From Sync 

1. Select the file(s)/folder(s). To select, click on the checkbox beside the file(s)/folder(s) name. You 

may select multiple file(s)/folder(s) at a time by clicking on the checkbox. 

2. Select Remove From Sync  located at the top panel. 
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3. The pop-up below would be displayed for the user to confirm the remove from sync process. 

 

 

11.3 Sync Setting 

Sync settings allow user to set sync intervals, sync changed file(s)/folder(s) and sync the whole directory. 
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1. Click on the File Tab located at the top panel. 

2. Click on Settings  

 

3. A pop-up window will appear. 

4. Click on the Sync Status  icon to navigate to the Sync Status. 

 

 

11.3.1 Sync Now 

Sync Now allows users to Sync all changed files from the server to the EasiShare and vice versa. 

1. Refer to step 1 to 4 of Sync Setting. 
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2. Click on Sync Now. 

 

 

11.3.2 Full Sync 

Full Sync allow user to scan and sync the whole directory for any changes that was in the server to 

EasiShare and vice versa. 

1. Refer to step 1 to 4 of Section Sync Setting. 

2. Click on the arrow button for more options. 

3. Click on Full Sync. 

 

4. The pop-up below would be displayed for the user to confirm the perform of full sync. 
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11.3.3 Sync Interval 

Sync Interval allows users to define how frequently EasiShare checks the server for changes to files that 

have been added to sync. For example, setting the Sync Interval to 5 minutes means that EasiShare will 

upload or download any changed files every 5 minutes. 

 

Additionally, if the EasiShare desktop client detected file changes in real time, the upload will happen 

immediately without waiting for the next scheduled sync. 

1. Refer to step 1 to 4 of Section Sync Setting. 

2. On Sync Interval, click on the dropdown arrow. 

3. Select the interval in minutes. 

4. Click on Save. 

4 
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12 Monitor 

EasiShare’s Monitor feature allows all users to keep track of the changes made to the files such as 

modifications, deletions, and new uploads etc. You can get a notification via email whenever a file or 

folder is changed in your drive(s). You may see different options when you monitor a file or folder. 

 

12.1 Monitor A File 

1. Select the file that you wish to monitor. 

2. Click Monitor  from the top panel. 

 

3. Select the options. 

4.  
Option Description 

Changes > Modified When the file has been overwritten 

Changes > Deleted When the file has been deleted 

Changes > Unlocked When the file is Discard Check-Out 

Changes > Share Changed When the file was shared 

Frequency To control when you receive an email notification 

• Immediately  

• Daily (Default: 9AM) 

• Weekly (Default: Monday) 

When Available selection: 

• Any changes 

• Someone else changes 

• Any changes to document created by me 

• Someone else changes documents created by me 

• Someone else changes document last edited by me 
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5. Click Monitor 

 

6. Once the file is successfully added to Monitor, you should see a Monitor icon beside the file 

name. 

7. You can check all Monitored files in Quick Access > Monitor 

 

12.2 Monitor A Folder 

1. Select the folder that you wish to monitor 

2. Click Monitor from the top panel 

 

4 2 
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3. Select the options 

 

 

Option Description 

Changes > New Uploads When a file is uploaded in the folder and any of its subfolders 

Changes > File Modified When any file has been overwritten 

Changes > File Deleted When any file has been deleted 

Changes > File Unlocked When any file is Discard Check-Out 

Changes > Share Changed When any file was shared or unshared 

Changes > Manage Changed When the folder and any of its subfolders have 

added/removed/edited managed permissions 

Note: This selection only affects folders and the following 

‘When’ Options do not apply: 

• Any changes to document(s) created by me 

• Someone else changes document(s) created by me 

• Someone else changes document(s) last edited by me 

Frequency To control when you receive an email notification 

• Immediately 

• Daily (Default: 9AM) 

• Weekly (Default: Monday) 

3 
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4. Click Monitor 

 

5. Once the folder is successfully added to Monitor, you should see a Monitor icon beside the folder 

name. 

 

When Available selection: 

• Any changes 

• Someone else changes 

• Any changes to document(s) created by me 

• Someone else changes document(s) created by me 

• Someone else changes document(s) last edited by me 

4 
5 
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6. You can check all Monitored folders in Quick Access > Monitor 

 

12.3 Stop Monitoring a File/Folder 

1. Select the file/folder that you wish to stop Monitoring 

 

2. Select Monitor from the top panel. 

3. Click on Stop 
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13 Workflow 
This section explains how to create a Share or Manage Folder approval workflow that requires agreement 

from all or any assigned approvers before the action is approved. A Share workflow requires approval to 

share a file or folder, while a Manage Folder workflow requires approval to move, copy, or perform 

administrative actions on folders. This feature helps enforce your organisation’s security and policy 

requirements. 

 

13.1 Owner Creates Workflow 

1. Select the file/folder that you wish to create a workflow

 

2. Click on Create Workflow in the top panel under Workflows tab

 

1 
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3. Select workflow type, then click Proceed 

 

4. Select the approver(s) 

5. Select ALL must approve or ANYONE can approve 

 

6. Click Apply 

 

13.2 Owner Edits Workflow 

1. Click Manage Workflows  in the top panel under Workflows tab 

 

2. Select the file/folder that you wish to edit a workflow. 
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3. Click Edit 

 

4. Select the approver(s). 

5. Select ALL must approve or ANYONE can approve. 

6. Click Apply. 
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13.3 User Checks Pending Approvals and Remind Approvers 

1. User shares a file/folder as per Section Share. 

Note: A Share Approval Workflow appears if a Workflow was created. Click Yes. 

 

2. To check on requests pending for approval, click on Shared > Pending 

3. To send a reminder, select a pending request. 

4. Click on Send Reminder  in the top panel. 

 

 

13.4 Approvers Approve or Reject with Comments 

1. To review a Share Request, navigate to the Workflow tab. 

2. Click Review Approval Requests  

1
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3. A popup window will appear, select a file/folder. 

4. Select Approve  or Reject  

 

5. If Reject is selected, enter a reason for the rejection to inform the user (optional). 

6. Click Reject. 

 

2 
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